
Address for windows is designed to be a "light" address book for business and personal use.    It 
represents information esthetically and with unmatched clarity.    A major design goal was to make every 
tool and feature of the program self-explanatory and highly intuitive.

We highly recommend that you will refer to the help topic on Things to know at some point.    It
contains a summary of useful information which otherwise has to be dug up by reading most of this help 
file.

Feel free to distribute evaluation copies.    Please upload evaluation copies to your favorite BBS and FTP 
sites.
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The Shareware concept

Very simple.    We cut the middle man.    We provide you with top quality software at a very affordable 
price, and in return, we only ask you to register the software if you use it.

There is really no excuse not to register this software, for the price is quite practical.    Even a college 
student can afford it!

One last note, Address is commercial quality software.

See Also
Registering your copy of Address



Things to know

We Highly recommend to read this help topic.    Note that you will probably need to read this twice.    Once 
after using Address a few times, and a second reading after you are more experienced with Address for it 
is sometime assumed you are familiar with the operation of the program.

- If one presses the tab key in a dialog box, the focus moves to the next control in the sequence.    
In order, then, to tab in any edit control one must press control-tab.    Hence, if you want to tab in 
the note field, press control-tab.

- In order to have Address load a file automatically for you when it starts, specify the file name in 
the "Autoload File" in the Global Settings Window under the options menu bar.

- If you like Address to automatically load a default export layout file, then name an export layout 
file in the Export Layout Window as "default."

- When you edit the Rolodex Card Details, if you wish to change the font of a field double click it 
with the left mouse button.    See Editing Rolodex Card Details.

- When in doubt press F1 for immediate friendly help.

- If you change the database field names using the "DataBase Specific Setup" menu 
item under the Options menu bar, then just keep in mind that this change is only visual.
In other words, when there is a need to refer to the actual fields, you will still
have to use the original field names.    So, for instance, in the "Edit Import/Export"
Window Address will still use the original field names to define the structure
of imports and exports.

- The Dial button always refers to either the last selected text or last clicked field, while the Copy 
Link button always refers to the last clicked field.    See Functionality of the Main Address Window

- If there is text in one field, like the note field, that you would like to copy to another
field.    Just select that text and drag it with the right mouse button to the destination 
field.    If the destination field has an area selected then only that selected text will
be replaced with the dragged text.    If there is no selected area in the destination
field, then the entire field will change to the dragged text.

 

- You can change the way in which Address builds the Index Window (see "DataBase Specific 
Setup" menu item under the "Option" menu bar).    However, note that if you 
instruct Address to index by, for instance,    the Last Name field, and there is a record with
the last name field empty, then Address will use "Organization, Last Name, First Name" 
scheme to Index the record.    But if all the latter fields are also empty then the record is 
considered to be invalid, and the user will not be permitted to perform any other action (except 
deleting the record) before filling at least one of these indexing fields.

A sequence of Index Fields such as "Organization, Last Name, First Name" indicates
the priority each fields gets when building the Index Window.    In this example, if the
Organization field exists, then it is used, otherwise if the Last Name field exists then
it is used and so on.



- You can always get technical support whether you are a registered user or not in CompuServe 
forums, via CompuServe mail (72603,666) or Internet email (72603.666@CompuServe.Com, 
make sure to use a dot and not a comma). 

If you are in the US you may call 1-800-390-7112 during regular business
hours and ask for a GIR representative.    Out side of the US you can call
(508) 584-7112 and ask for a GIR representative.

In addition, if you experience any difficulties with the software, please send us
a note about it.    Bugs exist in all programs, and only through massive and 
exhaustive use can programs be effectively "cleaned."

- It is very difficult to maintain the latest version of Address on FTP sites.    Generally, any public 
distribution via electronic means is virtually impossible to control.    However, you can always get 
the latest version from us.    One except is CompuServe, where you can always find the latest 
release. 

See Also
Moving Around in Address
The Shareware concept
Registering your copy of   Address  



"Talking" to other programs

Note: 
For infrequent data transfers such as when Addressing a letter, it is much quicker and 
practical to use the command menu "Edit/Copy Record" than using DDE (See Export 
data to clipboard and other applications). 

DDE is usually used for more frequent automated uses such as Addressing the same 
letter to a number of people.    On the other hand, for massive data merging, the best 
way is to export the data into a comma delimited file and use your Word Processor's 
merging capabilities.

Address can communicate with other windows applications such as word processors via a communication 
protocol known as DDE (Dynamic Data Exchange).    In effect, this means that if you would like to address 
a letter to someone, for instance, you can instruct Address to fill all the appropriate information for you at 
a click of a mouse.

Setting up DDE links (as the terminology goes) is as simple as three mouse clicks.    You click on the field 
you want Address to send to the other application, then you click on the "Copy Link" button.    You switch 
to the other application you would like the information transferred to such as Word for Windows, AmiPro, 
or WordPerfect for Windows (or any other windows application that supports DDE), and click the 
Edit/Paste Link menu item.

If you save your word processor document, the links are also saved.    When you load the same document 
again on a different occasion, the links between the word processor and Address will be automatically re-
established.    Most of the time, the application which saved the document will also offer you to start 
Address if it is not already running.    If, however, some application vendor had the brevity of not 
implementing this feature, then you will need to start Address yourself.

Notes
Some applications provide an embedded programming language.    For instance, Word for Windows 
implements WordBasic, AmiPro and Excel implement macro languages.    Often such embedded 
languages provide means to establish "manual" DDE links.    The appropriate Application, Topic and Item 
settings to access fields in Address follow:

Set the Application Name to "Address", Topic to "Info" and Item to the name of the field (excluding 
spaces).    For example, in Word for Windows you would use the field "{DDE Address Info FirstName}" to 
extract or set (in DDE terminology "poke") the current content of the "First Name" field.

See Also
Things to know
Moving Around in Address



Registering your copy of Address

First of all, if you have any suggestions or comments please feel free to write us or call us.    No matter 
how radical or how trivial your suggestion is, let us know about it!    You can always write to the mailing 
address given below, email to the Internet address 72603.666@CompuServe.com, directly to the 
CompuServe address 72603,666 or call 1-800-390-7112 from anywhere in the US and ask for a GIR 
Representative; calls from out side the US    (508) 584-7112.

You may distributed the evaluation copy of Address to anyone.    In fact, please upload a copy of Address 
to your favorite ftp site or BBS.    Suggest the software to your friends or associates, and who knows you 
might even impress your boss!

If you decided that you like Address and would like to register it.    Please send a check (payable to GIR) 
or money order for the sum of $25.00 (international orders please add $5.00 for shipping and handling) in 
US funds to:

GIR, Address for Windows.
P.O.Box 680
Randolph, MA 02368

Or you can register via CompuServe Shareware Registration Forum (GO SWREG) for $29.00.    Note 
that CompuServe accepts all major credit cards.

You will receive the latest version of Address, update notices, printed manuals and 30% discount on the 
next release of Address.    And of course, you have 30 days money back guarantee.

If you are not registering via CompuServe Shareware Registration program, then please copy the 
following text segment using Windows' help Edit/Copy feature.    Paste it to your editor, and fill the 
information out. 

------ Copy from here ------- 
Personal Information:
First Name:
Last Name:
Address:
City:
State/Country:
Zipcode:
Phone number:

General Information (optional):
What do you think about the program?

Is there anything you would want to see in the next release?

Where did you get a hand of your copy of Address?

Were would you suggest uploading Address to, 
or where would you suggest advertising Address at?



------ Upto here -------



DDE is just short for Dynamic Data Exchange, which is a protocol internal to Windows that standardizes 
communications between applications.    One of the highlights of DDE is that you don't really need to 
trouble yourself with more than this definition, everything else is already taking cared of for you.



The definition of a field sounds more complex than a field really is.    Hence, away with it.    Examples of 
fields are the boxes you edit in Address's main window such as "Phone Number," "City," "State," "First 
Name," "Last Name," and so on. 



Record is just the collection of fields.    For instance, each person you enter in Address has it's own 
record.    In it, each field contains the information specific to that person (such as the person's name, 
phone number and etc..).



Index Window

The operation of this window is very simple.    It works just like a common phone book index except that 
letters which have no entries are not displayed:

Next to each letter you see either a close folder or an open folder.    In order to close a folder or open one 
double click the line on which it stands.    To access individual records simply point the mouse at the 
record and click!

When printing rolodex cards or mailing labels you can assign records to rolodex cards or mailing labels by 
simply dragging the record from the Index Window and dropping it onto the record or label. 

Dragging operations are only enabled when it makes sense to drag things around.    For instance, when 
you click on the Print Rolodex button, you will see a Layout of the rolodex cards.    At this time, dragging 
operations are enabled.    You can click a record in the Index Window, hold the left mouse button down 
and drag that record to the card you wish it assigned to.



Global Settings Window

This window enables you to configure address to your individual preference and taste:

In order to change an entry all you need to do is double click that entry.    If the entry requires text like the 
"Company" entry it will place you into editing mode where you can change the settings.    If the entry has a 
selection like the your modem's communication port, you will be presented with a list of choices, and so 
on....

There is only one required field you must fill and that is the "Full Name" field.    Address will not let you 
leave the Global Settings Window without providing your full name.    The reset of the fields have useful 
default values.    However, some of these values you might want to alter depending on your taste and 
hardware configuration.    Ensuing is a concise explanation of the fields:

Field Name Description and Notes
Deleting Records Enable if you wish Address to confirm with you on record delete 

operations.

You should generally enable this option in order to provide 
protection against data loss.    Note that you can recover the last 
deleted record by clicking on the menu option Edit/Undelete 
Record.

Saving Files Enable if you wish Address to get permission before saving 
changes to files.

Dial Prefix, Dial 
Suffix and Modem 
Port

This information is used to command your modem to dial phone 
numbers for you.

The default settings is for Hayes Compatible modems.    Virtually 



all modems are Hayes compatible.    Experiment with these 
settings by trying to dial numbers, chances are that it will work. 

If you encounter problems, reference your modem's manual or any 
communication software that currently works with your modem and 
fill in the information specific to your modem. 

Note that if the Dial Suffix ends with a "^C" (the character "^" 
followed by the character "C") after 20 seconds the Control-C 
character is sent to the modem, which on Hayes compatible 
modems aborts the dial operation.

Smart Dial and 
Local Area Code

When the Smart Dial is enabled, Address's Auto Dialer does not 
dial numbers blindly,    It attempts to figure out the actual digits that 
need to be dialed to reach the given phone number.

For instance, if your local area code is 617, and the given phone 
number is 617-963-0823, then it is wrong to dial 617 or 1-617 
when dialing this number.    Hence, Smart Dial truncates it to 963-
0823.    As another example, if the marked phone number is 508-
584-7112, then the Smart Dial will actually dial 1-508-584-7112, if 
your local area code different then 508. 

Smart Dial knows many more "tricks" to attempt at guessing the 
actual phone number.    However, before the phone is actually 
dialed, you are given the opportunity to edit Smart Dial's guess.

If Smart Dial cannot resolve the given phone number such as 
when calling over-seas, it will not processes the given phone 
number.    It will simply display the selected phone number.

Press F1 at the Address Main Window to learn how to tell the Auto 
Dialer which phone number to call when you click the Dial button.

Quick Access Files You can set up to four quick access files which Address provides 
as menu items under the File Menu Bar.    You can quickly access 
open these files by either clicking them in the menu or pressing the 
number to their left.

Autoload File In the program manager's properties, one can set the command 
line parameters for any program when it starts.    In Address the 
command line parameters expected is an Address file to 
automatically load when starting. 

If no command line is given, as is often the case, Address 
automatically loads the file given in Autoload File when it first 
starts.    If, however, no file is specified, then Address starts with no 
file loaded.

Save Layout If this field is enabled, Address will save the layout of the main 
Address Window and the Index Window.      The next time Address 
will start, it will restore the respective windows dimensions and 
positions.    If this field is disabled, the last saved layout will be 
loaded. 

Address records the layout each time a data file is closed, and 
restores it each time a data file is opened.



Address Main Window

This window is self-explanatory in many respects.    However, there are a few functionality issues that you 
should be aware of in order to take advantage of them:

If you wish to dial a number, either click on the field where the number is such as Phone and 
SecondPhone field or you can select the actual digits to dial with the mouse.    So for instance, if you have 
written a phone number in the notes field, you can select the text with the number and click dial.    The 
Auto Dialer always works with either the last text selected in the window, or if there is none, the last field 
clicked on in the window.

In the same style of the Dial button, the Copy Link button works with reference to the last field clicked.    
So if you wish to setup a link between Excel and the Address field of a person, you would click on the 
Address field, click on the Copy Link button and then go over to Excel where you would click the menu 
item Paste Link under the Edit menu.

As far as editing issues go, you can move between fields by pressing the TAB key.    You can go backward 
in the TAB sequence by pressing SHIFT-TAB.    If you tab in the note field, you will find that the input focus 
will move to the next field.    If, however, you would like the note field to accept the actual tab character, 
then press CONTROL-TAB.

Of all the fields FirstName, LastName, ZipCode, Notes... and so on you must fill at least one of the fields 
FirstName, LastName or Organization.    These fields are used to Index the record in the Index Window.    
Hence, in order to place the entry correctly in the Index one of these fields must be filled.    It's like putting 
someone in your Address book but not knowing that person's first name, last name or organization which 
this person is associated with.    How can you then decide where to write down his address and phone 
number?

When building the Index Window Address gives preference to Organization, then to Last Name and finally 
to the First Name.    Also realize that when you updated any of these three fields, the position of the entry 



in the Index Window could change. 

If there is text in one field, like the note field, that you would like to copy to another field.    Just select that 
text and drag it with the right mouse button to the destination field.    If the destination field has an area 
selected then only that selected text will be replaced with the dragged text.    If there is no selected area in 
the destination field, then the entire field will change to the dragged text.



Card Window

With this Window you can take complete control of the look and feel of your Rolodex cards.    You can 
change the location of each field on the card, the size of the card, and you can change the font with which 
that field will print:

Simply drag each field to the location on the Rolodex you wish it to appear.    Just click the field, hold the 
left mouse button down and move the field to the desired location where you should release the mouse 
button.

If you wish to change the font of any field, double click that field and a dialog box with all the available 
fonts will appear.

In order to test how the card will actually look, you can click the "sample" button which will replace the 
name of each field with data from the currently selected record in the Index Window.

Finally if you wish to change the size of the actual Rolodex card, you may do so by simply clicking on the 
width or height measure and edit the value to your desire.    The default settings of the width and height 
are set to the standard Rolodex card dimensions.    However, remember that when you change these 
values you are also changing the proportion between the screen and the print out.

And of course you can save all these customization details by clicking the save button for later retrieval.



Rolodex Window

With this feature, printing Rolodex Cards is as easy as it looks:

The Rolodex Card Window presents the layout of the most common Rolodex paper.    Simply drag the 
records you wish to print from the Index Window and drop them on the card you wish them to appear.

If you have already assigned a record to a card and you wish to change this assignment simply drop a 
different record on that card.    And if you would like to "empty" a card simply click on the card and press 
the DELETE key.

All that you know have to do is click the print button and your cards will be printed-- it is as simple as that!

Considerations
Before you can print your cards, you may need to go into the Control Panel and change the printer from 
Portrait printing to Landscape printing:    Execute the Control Panel from the program manager.    Double 
click the printer icon in the Control Panel, click the setup key and on the left lower side of the window you 
see there should be a choice between Portrait and Landscape.

Although the default settings is for standard Rolodex paper, you can easily change the locate of of each 
card on the page.    Double click a card, and a window that enables you to alter that cards' position on the 
page will appear:



In effect, you can completely rearrange the layout of the cards to your needs.    In practice, you can 
actually use this capability to print anything from envelopes to personalized diskette labels.    But most 
importantly you can save these different card layouts for later retrieval by merely clicking the save button.

In order to edit the details of the actual printing, click the "Edit Details" button where you can take 
complete control of your Rolodex card look and feel.



Export Window

The Export Window is an incredibly powerful tool that enables you to define precisely and easily how you 
would like Address to export data to other applications such as Word Processors, and spread-sheets.

The concept is very simple.    Using this window you can tell Address in detail how to format the record 
information (First name, Last name, Address and so on...) when exporting data for the clipboard or to 
files.    For instance, examine the following:

This list box shows you exactly how Address will convert the data when exporting (copy) to the clipboard 
or to files.    Examining this list box from top to bottom Address will do the following:    starting with the Title 



field, place a period at the end of the title field; place a space at the end of that.    Then append the 
LastName field, and augment the last name field with white spaces so that the total number of characters 
is 20.    Append the FirstName field and also complete the field length to 20 by adding white characters, 
and finally add an enter at the end.

This last sequence will look like this:
"" Starting with an empty string.
"Mr" Adding the Title field.
"Mr." Adding a period.
"Mr. " Adding a space.
"Mr. Weissman" Adding the LastName field.
"Mr. Weissman                " Extending the LastName field to be 20 characters long.
"Mr. Weissman                Richard" Adding the FirstName field.
"Mr. Weissman                Richard 
"

Extending the FirstName field to be 20 characters long.

"Mr. Weissman                Richard 
"

Appending an enter.

Defining such layouts is extremely easy.    Simply select the field you would like to Add in the left list box, 
click the arrow that is pointing to the right list box and the field will be inserted at the current position.    
You can enter as many fields as you like, repeat a field as many times as you like, and in whatever order 
you wish.    Finally you can move fields up and down their placement in the "Export Arrangement" list box 
by selecting the field and clicking the up and down arrows.

In addition to selecting the ordinary information fields (Phone, Fax, Notes, City, State....) you can also 
append special fields that perform special actions.    For instance, the Effect field will change the letter 
case of the last ordinary field to all upper case or all lower case.    You can compound special fields in 
succession as you like.

You can change the special fields Effect and Character by double clicking them either in the left or right 
list box. 

In addition, you can tell Address in what format to export the data.    Some applications can handle tab 
delimited information or comma delimited information better than it can plain text.    For instance, in plain 
text the example given above would of produced in the clipboard or output file "Mr. Weissman                
Richard                      <enter>"    while in a comma delimited format it would of produced "Mr. ","Weissman 
", "Richard                    <enter>"

Notice that the special fields always take effect to the last ordinary field, and are therefore included within 
the quotes.    In order to further aid in moving information to other applications, the special field Blank 
Field is provided.    For instance, if you would like to move records into Microsoft Works for windows but in 
your database set up you have entered a middle name between the FirstName and LastName fields.    



Hence, when you attempt to move the information, the LastName field would fall in the middle name and 
all other field would be shifted back one field.    Thus, if you put the Blank Field between the FirstName 
and LastName in the Exporting Arrangement, the middle name field in your database will be correctly 
skipped.

The Export Arrangement list box is in effect powerful enough to render the Clipboard Format selection 
obsolete since you can imitate the exact format desired by using special fields.

Of course you can save all your different Export Arrangements in files.    And since we wanted our clients 
to have fast access to such arrangements, you can just click on the Layout Arrangement File in the 
bottom left list box, and your defined arrangement will be automatically loaded. 

You can save new arrangement or old arrangement under new name by editing the desired file name in 
the text box above the list box and clicking the save button.

Note that if you save an arrangement named "default" then it would be loaded automatically when 
Address starts.



We believe that it is time that quality software will start to be more affordable.    Help us start the change, 
register your software.



Address and this help file are Copyrighted(c) 1993 by GIR Software, Randolph, MA.

There is no warranty, not implied or expressed, not even of workability, with this unregistered 
copy of Address.    In no event shall GIR or its suppliers be liable for any damages whatsoever 
(including without limitation, damages for loss of business profits, business interruption, loss of 
business information, or any other pecuniary loss) arising out of the use or inability to use this 
GIR product, even if GIR has been advised of the possibility of such damages.

The registered version of Address provides a warranty and guarantee of operation.



Importing and Exporting

This section is more of a guide to exporting/importing than anything else.    Specific technical notes 
regarding an import/export information can be found in the help topic on the manner.    However, you 
should really read this help topic even if you are an experienced user for it contains general guidelines to 
use Address correctly.    A section on importing can be found at the end of this help topic.

The flexibility of the "Edit Import/Export" window was designed to help the user export information to other 
program easily and on regular basis.    For instance, you can use your Word Processor such as Word for 
Windows, AmiPro or WordPerfect to actually print envelopes.    But instead of typing the mailing address 
you can have address format the exported record to match exactly what you would type.

In our example, you would most likely tell address (in the "Edit Import/Export" Window) to do the 
following:

- Take the organization name, capitalize it, and enter
- Add the First name, space, Last Name, and enter
- Add the address, and enter
- Add City, comma, space, state, space, Zipcode, and enter
- Add Country and enter.

Then whenever you wish to address a letter, you can simply access the record with the information, click 
the "Copy Record," switch to your Word Processing program and Paste the text.    One can be very 
creative with the powerful exporting mechanism implemented in Address.    Just use your imagination.

If, on the other hand, you wish to send the same letter to many people such as when mailing information 
to your clients, you can have address format the records in comma delimited format.    And then using 
your Word Processor's merging capabilities to create your entire mailing lists quickly and easily.

Comma delimited databases is the standard in merging information with Word Processors and such.    If 
you are using any word processor or program that support some kind of database information, chances 
are that program supports comma delimited files.    As an aside, comma delimited files are simply 
databases with each record on a line and each field in a record separated by a comma and enclosed in 
quotation marks.

Importing
You can have Address merge records to an existing database from comma delimited files and Windows' 
Card File.    When you import comma delimited files be very careful to define the precise comma delimited 
fields in the "Edit Import/Export Window."    The number and position of each field in the comma delimited 
file must match exactly the number and position in the "Edit Import/Export Window."    In case you fail to 
make an exact match, there can be loss of data and errors generated. 

While importing Address only looks at the field names, the special "Blank Field," and disregards all other 
special formatting capabilities present in the "Edit Import/Export Window." 

Upon importing any record, Address validates the record to see if it contains proper indexing fields (one of 
FirstName, LastName or Organization).    If not, it attempt to recover the record by assigning a bogus 
indexing label in Organization field.    If, however, the record is still invalid after this attempt at recovery the 
record will not be imported.

In Window's Card File program, the user enters information free style, while in Address information is 
distributed among fields.    Because of this when importing information Address cannot know what to do 
with the block of text entered to the Window's Card File.    The current importing method is as follows:

The index lines in the Card File are copied to the Organization field in Address.    All other information 



goes into the Note field.    Pictures and OLE objects are skipped.    The user is then supposed to select 
text in the note field and drag it with the right mouse button to the appropriate field.

These are some notes on selecting text in any field:    The user can double click with the left mouse button 
any word and it will be highlighted.    Holding down the shift key and selecting more text, adds the new 
selection to the old one.      The user can than just drag the selected text with the right mouse button to the 
destination field.    Note that if the destination field has a selected region, only that selected region will be 
replaced with the dropped text.

As of now there is no apparent need to have Address recognize DBase files directly.    The current 
philosophy on the issue is that any program that supports DBase files most probably also support comma 
delimited files and the purpose is served. 



New Features

If you have any suggestions or comments about any aspect of the program from visual all the way to 
operational, let us know about.    Virtually all new features to version 1.1 is a result of people like you 
that had an idea....    All reported bugs have been fixed.    Registered users of version 1.0 receive a 
free upgrade to version 1.1.

New to V1.1 Refer to
- Open All/Close All/Search Buttons on Index Window Index Window
- Robust and Improved Indexing System
- Inter-Field right mouse button text dragging Functionality of the Main Address Window
- Change Indexing/Sorting methods/fields "DataBase Specific Setup" under "Options"
- Custom field names "DataBase Specific Setup" under "Options"
- Change Dial Prefix for long distance phone calls "DataBase Specific Setup" under "Options"
- AutoDial middle-of-operation cancel button Dial Window
- Two visible lines to the Address Field (used to be 1)
- Larger ZipCode Field Importing and Exporting
- Importing Comma Delimited Files Importing and Exporting
- Importing Windows Card Files See "Find" under the "Edit" menu bar 
- Any field forward and backward searching Importing and Exporting
- Copy Record button in place of Copy Link Button
- Revised help topics "Things to Know" help topic
- New help topic "Exporting and Importing" 
- New help topic "New Features" Registering your copy of Address
- New Registration terms



Moving Around...

These are quick notes regarding special functionality in Address:

- One can drag text between fields by selecting text with the left mouse button and dragging 
with the right mouse button.

- Pressing an enter in a field has the same reaction as pressing the TAB key.    Except when in 
the Address field or note field for these fields actually accept the enter key into the text.

- Double click a rolodex card.    You'll be able to change the actual position of the card on the 
page.    Although the default setting is for standard Rolodex Cards.

- Click on the card's dimensions in the "Card Details Menu," and you will be able to change the 
actual width and height of the card.

- Double click a field in the "Card Details Menu" and you'll be able to change that field's font.

- When using any of the "Choice List Boxes," these are used in the Global Setting and the 
DataBase Specific Window, double click an item in order to edit it.

- To create or "Save As" Export Layout Files in the "Edit Export/Import" menu item under the 
"Edit" menu bar, just type a new name in the text box above the list box at right lower corner 
of the window, and click the "Save" button.

- Always press F1 to help on the current screen.

- Tab moves to the next field, Shift-Tab moves to the previous field.

- Learn how to use the "Edit Import/Export" function along with the "Copy Record" button.    The 
knowledge will save a lot of time and effort.

- In order to enter new records, just click the new-record button and type away; Address runs 
on "auto-pilot" from there on.

- To change which fields Address uses to build the Index Window look at "DataBase Specific 
Setup."

- To customize Address look in the "Global Settings Window" accessible under the options 
menu bar.




